
F irst, we must under-

stand that photograph 

(image) size in the camera 

and in the computer is 

measured in pixels. These 

are the basic dots of color 

that make the picture. Do 

not pay any attention to 

anything that says “inches” 

or "pixels per inch.” These 

terms are meaningless 

when we are considering a 

picture either in the camera 

or in the computer. They 

may come into play later if 

we want to print the photo 

on paper. But, that is an-

other subject for another 

time. For now, we think 

only of pixels. Most cam-

eras record too many pixels 

to e-mail. For instance a 6 

megapixel camera will 

make a picture about 3000 

pixels wide by 2000 pixels 

tall and the file size may be 

several megabytes. Our 

screens are usually only 

about 1000 pixels wide 

(some are larger and some 

smaller). So, if we e-mail 

the native picture, it will be 

wider than the screen for 

the recipient and the file 

will be so large, it may take 

“forever” to download to 

the recipient‟s computer. It 

is possible the service pro-

vider will not even accept 

it.  

There are two things we 

must do to make a photo e-

mailable. The first is to 

resize or resample the pic-

ture. We want to change 

the picture width from 

3000 pixels to 800 pixels, 

for instance. This process 

is called resizing or resem-

bling. We have to pick the 

best 800 pixels out of the 

3000 to represent our 

photo. Well, no, that is not 

exactly correct but it sim-

(Continued on page 4) 
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Dymo DiscPainter 

CD Labeler Extraordinaire 

By Gypsy D. Katz 

 It‟s no bigger than a small 

shoebox; with a higher 

back part that conceals the 

ink cartridge. In fact, I‟ll 

have to admit it sort of 

looks like a mixture of the 

Atari Jaguar and a toilet 

stool.  OK, bad jokes aside, 

inside the 

box, you‟ll 

find the typi-

cal things… 

USB connec-

tor, power 

supply, soft-

ware, a few blank printable 

CD-R‟s, a Dymo ink jet 

cartridge and a “Quick 

(Continued on page 5) 
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MEMBERSHIP 

Membership for LCACE is open to all individuals and 

families interested in personal computing. Annual dues 

are $20.00 per individual/family. Associate membership 

is only $10.00 (out of state, unable to attend meetings). 

Membership includes a one year subscription to the 

LCACE News Journal and access to all club libraries and 

functions. Applications for membership may be obtained 

at the monthly meeting, by request on the club Hotline, 

and are now available on our WEB site at  - 

http://www.lcace.org. 

MEETINGS 

LCACE meetings are usually held on the second Satur-

day of each month at the Grayslake Area Public Library, 

100 Library Lane, Grayslake, Illinois. The meeting room 

opens at noon and  the formal meeting begins at 12:30 

p.m.  All meetings are open to the public.  Bring a friend! 

ADVERTISING 

Ad rates per issue: Full page - $25, Half page - $15, 

Quarter page - $10, Business Card - $5. Discounts are 

available on advance purchase of multiple issues. Please 

send camera-ready copy and payment to the club address 

by the 21st of the month preceding publication. For more 

information on ad pricing, please call our Hotline. Ads 

are FREE to all paid members. 

 NOTICE 

LCACE WILL NOT CONDONE  or knowingly participate in 

copyright infringement of  any kind. The LCACE News 

Journal is published by and for LCACE members. Opin-

ions expressed herein are those of the individual au-

thors and do not necessarily reflect the opinion of 

LCACE, the membership, the Board of Directors, 

and/or our advertisers. 
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 I hope you attended our 

August 9th meeting which 

featured Mundelein Best 

Buy employees: Adam 

Cash, Mobile Manager; 

Ron Aldana, Geek Squad 

Supervisor; and Joe Neu-

hengen, Customer Assis-

tant Supervisor.  They dis-

cussed air cards, Skype, 

webcams, internet security, 

etc.  Each person received 

a 12% off coupon for the 

Mundelein store. Lew Sei-

denberg won the door 

prize, an LG Bluetooth 

headset, which Best Buy 

donated.  Member com-

ments included: “Great 

meeting”, “One of the best 

programs we‟ve ever had.”  

We look forward to these 

great guys returning to 

LCACE in the spring.  

 We saw a number of new 

faces at our August meet-

ing.  After attending this 

wonderful program, we 

hope they will return and 

become members. 

LCACE vice president 

Mike McEnery will discuss 

Windows Live One Care 

on September 13th. We 

will also have “Show and 

Tell”.  If you have a new 

“toy”, we‟d love to hear 

about it.    

Our October 11th program 

will feature one of our 

most popular programs, 

“Ask the Gurus”. Plan to 

bring your questions, and 

our gurus will answer 

them. On Saturday, No-

vember 8th, LCACE and the 

Grayslake Area Public Li-

brary will co-sponsor Sue 

W a l t e r ' s  p r o g r a m , 

“Computerized Embroi-

dery”. Sue will show us a 

design, then digitize it on 

her laptop, and use her 

computerized embroidery 

machine to stitch it. She 

will also discuss websites 

where one can download 

beautiful designs-often at 

no charge.  

Treasurer Winnie Frost 

(treasurer@lcace.org) is 

chairing our annual holiday 

party which will be held 

December 6th at the Uni-

versity of Illinois Exten-

sion Building on Route 45 

in Grayslake. Winnie's co-

chairs are vice president 

M i k e  M c E n e r y 

(vp@lcace.org) and mem-

bership chair Linda Busch 

(membership@lcace.org).  

If you would like to help 

on the holiday party com-

mittee, please email Win-

nie, Linda, or Mike.  

Our January 10th, 2009 

meeting will be another 

“Show and Tell” and “Ask 

the Gurus” program. 

 What programs would you 

like LCACE to have in the 

future? Please email Mike 

M c E n e r y  o r  m e 

(president@lcace.org) with 

your ideas.     

 Robin 

Robin's RAMblings 

“To catch the 

reader's attention, 

place an interesting 

sentence or quote 

from the story 

here.” 
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From left to right: Ron Aldana, Geek 

Squad Supervisor, Joe Neuhengen Cus-

tomer Assistant Supervisor, and  Adam 

Cash Mobile Manager. 

Some of the things  the Best Buy Team 

discussed. 

Member  

Update Form 

If you are not receiving the 

meeting  email messages 

from the J.J., it is possible 

the club does not have your 

correct address. Please go to 

http://lcace.org/Documents/

Application.pdf  Download 

the Application form, fill in 

the information that needs 

correcting/updating. Bring 

the form to a meeting and 

give it to Linda Busch our 

Membership Chairperson. 

Another problem might be 

that your email client (such 

as SBCGLOBAL) is block-

ing our address. Put 

jj1450xl@yahoo.com in 

your address book for the 

sole purpose of receiving 

this email. 



plifies things to think of it 

that way. We don‟t have to 

worry about it because a lot 

of very smart grammers 

have developed ways 

(algorithms) to help us. 

Just remember, you want to 

resize or resample to get 

the photo down to a size 

convenient for e-mailing. I 

usually use 800 pixels or 

900 pixels width for pic-

tures I attach to e-mails. 

 The second thing to do to 

make a photo e-mailable is 

to save it in JPEG format 

(.jpg). That is a format 

that reduces file size a lot 

and picture quality a little 

so the picture can be 

downloaded more quickly 

and still be nice to look at. 

Some software programs 

give you choices of com-

pression amount with num-

bers ranging from 1 to 10. 

One will result in a very 

small file but the picture 

quality will not be good at 

all. A 10 will give the very 

best quality but with a very 

large file size. A reason-

able compromise is to use 

5 or 6. I usually use 6. 

 How do you do this? First, 

I will describe how to do it 

with a free Microsoft pro-

gram. Then I will try to 

look at some other pro-

grams.  

(Continued from page 1) Microsoft Power Toys for 

XP has a Resize Pictures 

toy that is slick and easy 

but feedback says it only 

works on XP. It can be 

downloaded at  

http://www.microsoft.com/

win-

dowsxp/downloads/powert

oys/xppowertoys.mspx.  

Right click on an image 

name or thumbnail in Ex-

plorer or My Computer and 

choose Resize Pictures. 

You are limited to four 

specific sizes but they are 

good choices. They don‟t 

tell us what compression 

they are using but the re-

sults look OK. Unless you 

tell them under Advanced 

to replace the image in the 

file, it will make a copy. 

That‟s good. They will add 

the word, “Large”,  

“Medium” or “Small” to 

the end of the name you 

have chosen. 

 If you are happy with this 

solution, then read no fur-

ther. But, if you want to 

use a picture editing pro-

gram, maybe this will help.  

In Photoshop Elements 5, 

click on Im-

age>Resize>Image Size 

and this window will pop 

up. Note that there is some 

garbage at the bottom 

about “inches” but we will 

ignore that. First we will 

click the Resample Image 

box. That puts the Pixel 

Dimensions in play and 

that is what we want. I se-

lected the Width box and 

changed the width to 800 

pixels. Since the Con-

strain Proportions box is 

selected, that is all I have 

to do.  

Note, down at the bottom, 

that we have several 

choices of sampling algo-

rithms. This is frosting on 

the cake. I read somewhere 

that I should use Bicubic 

Sharper when downsizing 

so that is what I do. Most 

programs don‟t give us all 

these choices. Then we 

should click on File>Save 

As and give the photo a 

new name. I often just use 

the same name and add 

“_800px” so the next time I 

will know it is ready to e-

mail. Here we can choose 

the JPEG format and the 

compression amount. Pho-

toshop Elements 6 is out 

now and sells for about 

$100. If you are able to 

spend that much and want 

one of the best editing pro-

grams, I highly recommend 

it.  

Let‟s look at Picasa2. It is a 

free program from Google 

and looks really good but I 

do not have much experi-

ence with it. By all means, 

try it first because the price 

is right! When it comes to 

e-mailing photographs, it is 

a little more automated but 

not any easier to use than 

(Continued on page 5) 

E-Mailing Photographs 

Elements 6 is out 

now and sells for 

about $100. If you 

are able to spend 

that much and 

want one of the 

best editing 

programs, I highly 

recommend it.  
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Elements. First, click on 

Tools>Options>E-Mail. 

Then select the width you 

want in pixels. There are 

six choices. Then click on 

Apply and OK.  

The next step is to click on 

File>E-Mail and you will 

get three choices of how 

you want to e-mail your 

photos. Fortunately, I use 

Outlook Express so my 

choice is listed. 

 When I clicked on Out-

look Express, an email  

page popped up with the 

photo attached. At this 

point we can write some-

thing else on the e-mail and 

send it. I recommend this 

so the recipient will know 

it is really from you and 

not something sent out by a 

virus. When I receive e-

mails that only say 

“Attached”, I Delete them 

without looking at the at-

tachment. This saved me 

one time when I received a 

(Continued from page 4) virus from my sister-in-law 

that she did not know she 

sent. She spent weeks and 

dollars getting her com-

puter back up. 

Oh, I digress. If you want 

to send more than one pic-

ture (and, who doesn‟t?), 

you must select the picture 

and click on the Hold but-

ton near the bottom of the 

screen. Do this for each 

photo you want to send and 

they will all be attached to 

the e-mail. The program 

automatically chooses 

JPEG format and a com-

pression ratio but does not 

tell you. That is OK as the 

pictures I tried looked 

good. Picasa2 has consid-

erable capability for editing 

photos in many respects. 

Try it!  

There are many other edit-

ing programs that I haven‟t 

mentioned and have no 

experience with. In all 

cases you want to change 

the picture‟s size in pixels 

by resizing or resampling. 

Pay no attention to any-

thing that says “inches” as 

that will have no meaning 

for this process. Sometime 

later we will talk about 

printing pictures and then 

we will use inches. 

 This article has been provided to 

APCUG by the author solely for 

publication by APCUG member 

groups. 

All other uses require the permis-

sion of the author (see e-mail 

address above) 

window, and pop in a 

printable CD face up, data 

side down and then open 

up the Discus application 

in order to start the printing 

process.  Open up the ap-

plication choose a template 

or create your own from 

your own images: jpg, png, 

bmp, among others. In this 

example, I used a 1600 

Start” pamphlet. I started 

this install originally in 

Vista; I was up and running 

from disc install to print in 

less than 10 minutes.  

Manually flip open the bot-

tom part of the printer, the 

part with the clear acrylic 

(Continued from page 1) 
pixels by 1200 pixels at 

72dpi Photoshop document 

that I had created a while 

back for a calendar image, 

exported out to *.png. The 

Discus for Dymo applica-

tion also includes the abil-

ity to add filenames via 

iTunes, or even add-

ing/synchronizing via tab 

(Continued on page 6) 

E-Mailing Photographs 

Dymo DiscPainter 
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Just In 

The Holiday Raffle Prizes are Announced 

1st  Prize 

Compaq Presario Notebook Computer 

2nd Prize  

Nikon Coolpix L18 Digital Camera 

3rd Prize 

Maxtor OneTouch 4 Mini 320GB Portable 

Hard drive 

4th Prize 

One Years Membership to L.C.A.C.E. 



delimited files. On Vista, it 

picked up my iTunes appli-

cation, and offered to im-

port filenames from iTunes 

or a tab delimited file to 

allow printing of those 

aforementioned filenames 

on the face of the CD.  

In goes a blank white, 

printable CD-R and the 

process is surprisingly fast. 

A picture via the Dymo 

DiscPainter at the best 

quality took about 3 min-

utes, tops. Seriously… 3 

minutes. And it‟s totally 

dry, huggable touchable 

once you take it out. 

Perfect each time too. 

Much unlike the messy 

Avery labels that require 

that applicator that haphaz-

ardly presses a disc down 

onto a label that might 

leave unsightly bubbles 

under the label - no matter 

how hard you press down, 

you still might get a bubble 

or two. In a slot loaded 

drive, that‟s something that 

might get stuck on entry or 

ejection, plus the labels 

sometimes separate from 

the disc while lying 

around… creating a sticky, 

nasty mess. Needless to 

say, printing directly onto a 

disc alleviates the fear of 

label separation. 

The cons? There are al-

ways a few:    

(Continued from page 5) The printer capacity is only 

one disc at a time. There is 

no stack loading, no way to 

just print and forget about 

it. If you‟re used to burning 

discs in your internal 

drives, this is not any dif-

ferent. Another minus 

would be the fact that 

you‟re likely going to be 

buying more cartridges 

very soon, and they‟re not 

normally in your Wal-Mart 

or other local store. But the 

cartridges are at your fa-

vorite online places like 

Amazon and B&H Photo, 

as well as the Dymo web-

site among others. 

All in all, the Dymo 

DiscPainter is worth every 

penny for just a printer. 

There‟s no optical burner; 

this is, however, a full-

color printer. I no longer 

have to try to read my hor-

rible writing  and my discs 

are nice and labeled.  

Despite the one at a time 

method using the Dymo 

DiscPainter, it‟s a recom-

mended buy if you‟re a 

disc backing up fool like I 

am. Perhaps for once I can 

now locate a disc by sight 

alone. With the software 

abilities to add filenames 

from other 3rd party appli-

cations like iTunes and 

other applications, that 

level of integration makes 

even my rigorous backup 

routine fun, colorful and 

easy to sort out at a later 

date.  

From the Editor 

 A board 

meeting was 

held prior to 

the August 

meeting 

where the Holiday party 

was discussed.  Plans were 

made for the raffle prizes.  

Remember the date Decem-

ber 6, 2008.  Make sure 

your calendar is high-

lighted.  Following that, we 

went right into the business 

meeting.  The folks from 

Best Buy in Mundelein 

gave 3 great presentations 

with the emphasis on “Air 

Cards” .  We are happy to 

say they will be back with 

other presentations in the 

future! 

I am looking for a „Club 

Historian”/assistant editor.  

Duties would include writ-

ing a monthly article on 

what happened at the meet-

ing, as well as taking pic-

tures.  The Club camera 

will be made available to 

you for this assignment.  

Please contact me at: vice-

president@lcace.org or 

(847) 571-7258. 

As always, we are in con-

stant need on articles for the 

Journal.  If you receive a 

new toy (technology- re-

lated) and would like to 

write a few sentences about 

it, please send it to me by 

the 1st of the month. 

Dymo DiscPainter Cont. 

Needless to say, printing 

directly onto a disc 

alleviates the fear of 

label separation. 
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Congratulations to Sherry Florian winner of the August 

2008 50/50 Raffle. 

And the Winner is  

wildlife, gives directions at 

important intersections, 

great photo viewpoints, 

suggests side trips to places 

you might otherwise miss, 

and tells quirky tales of 

Canadians (such as a tiny 

town on Vancouver Island 

that had the world‟s largest 

hockey stick. Of course, 

we stopped to photograph 

it.).  It also provided practi-

cal information such as 

“Check your gas gauge; the 

next gas station is 150 kilo-

meters away.” and “This 

area has clean rest rooms.”  

You want to know these 

things when you are in a 

remote area.  

We were able to tour at our 

own pace:  if an area 

looked interesting, we 

spent a long time there; if 

not, we continued on our 

way.  The city tour of Vic-

toria, for instance, was sup-

posed to take about 2 

hours.  We saw many 

places where we wanted to 

linger, take a stroll, lunch 

by the harbor, etc., so we 

took close to 5 hours.  You 

can‟t do that on a Grayline 

tour!  

When we first looked at the 

GyPSy Guide, it seemed 

quite pricey… until we 

looked at the cost of tours.  

Not only did (we save a 

good deal of money on 

tours, we were able to 

travel as we wished.  We 

realized how extremely 

useful our GyPSy Guide 

was when it didn‟t work 

(Continued on page 8) 

GyPSy Guide 

by Angus MacTavish 

  

During our recent trip to 

Western Canada, we rented 

a GyPSy Guide (=GPS tour 

guide), a neat marriage of 

technology and tourism.  

This small PDA attaches to 

the auxiliary port of your 

vehicle's stereo, to the 

power port formerly used 

for the cigarette lighter), 

and to your windshield.  It 

knew exactly where we 

were because it‟s a GPS, 

and gave us our own per-

sonalized tour.  As you 

drive through an area, it 

automatically plays an au-

dio commentary about that 

location.  It tells you about 

the beautiful scenery, sto-

ries of past explorers, ad-

vises where to watch for 

When we first 

looked at the 

GyPSy Guide, it 

seemed quite 

pricey… until we 

looked at the cost 

of tours 
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well in down-

town Vancou-

ver (Our own 

Garmin GPS 

wasn‟t work-

ing properly 

there either; 

evidently there 

was some sort 

of satellite problem.).  Instead of having 

to pore over maps and guidebooks as we 

drove, we listened to our own personal 

guided tour.   

If you are ever fortunate enough to visit 

the spectacular Canadian Rockies and the 

beautiful coastal scenery of Vancouver, 

Victoria, and Vancouver Island, I 

strongly recommend that you rent a 

GyPSy Guide to use in your vehicle.  It 

(Continued from page 7) 

GyPSy Guide 

L.C.A.C.E. News Journal 

can guide you all through Alberta and 

British Columbia for the trip of a life-

time.  

For more information about the 

GyPSy Guide, go to 

www.gpstourscanada.com. 

L.C.A.C.E. 

“Members Helping Members” 

OUR SPONSORS 



"Reprinted with permission 

from Smart Computing.  

Visit 

www.SmartComputing.com/

groups to learn what Smart 

Computing can do for you  

and your user group!" 

  Overall, Windows 

XP is a pretty good operat-

ing system. After all, it‟s 

still going strong after 

more than seven years, and 

even after all this time, 

some still prefer it over 

Microsoft‟s newest offer-

ing, Windows Vista.  

 But WinXP isn‟t 

perfect, so there‟s certainly 

room for some improve-

ment. That‟s why this 

month we‟ve found several 

handy programs and utili-

ties that can help make 

WinXP better. Many of 

them can be used as re-

placements for specific 

built-in WinXP applica-

tions or features, while oth-

ers either provide a feature 

that WinXP doesn‟t offer 

or correct one of the oper-

ating system‟s foibles or 

idiosyncrasies.  

 All these utilities 

are available via a quick 

and easy download, and 

best of all, they‟re free. So 

what‟s the catch? Well, 

there are a few minor ones. 

We‟ve used all these pro-

grams and found them to 

work, but because most of 

them come from smaller, 

lesser-known developers, 

it‟s probably a good idea to 

back up your system or 

manually create a restore 

point (select Start, All Pro-

grams, Accessories, Sys-

tem Tools, and System Re-

store) before installing or 

using them. Also, you 

shouldn‟t count on getting 

any technical support. (It‟s 

seldom, if ever, provided 

with free software.)  

 
Application Or Feature Re-

placements  

Sometimes, the tools in-

cluded with WinXP leave 

something to be desired. 

Here are some applications 

that provide extra features 

you might be looking for.  

  

 The AbiWord word proc-

essor gives you a nice al-

ternative to the limited 

WordPad without the cost 

of Microsoft Word. 

  

AbiWord. WinXP‟s inte-

grated WordPad word 

processor might be OK for 

typing grocery lists, but it‟s 

not good for much more. If 

you want a good word 

processor that will leave 

WordPad in the dust but 

would rather not spend the 

bucks on Microsoft Word, 

try AbiWord 

(www.abiword.com/downl

oad). It has a familiar and 

easy-to-use interface, a 

spell checker, and lots of 

advanced document layout 

features, and unlike Word-

Pad, AbiWord can save 

files in Word‟s ubiquitous 

DOC format.  

 

Auslogics Disk Defrag. 

Your hard drive should be 

defragmented regularly for 

optimal performance, but 

WinXP‟s integrated defrag 

utility tends to be slow and 

clunky, especially on older 

systems. Auslogics Disk 

Defrag 

(www.auslogics.com) is a 

lot quicker, and it provides 

better feedback during the 

defrag process. You can 

also adjust its CPU usage 

depending on whether 

you‟d prefer the defrag to 

finish as quickly as possi-

ble or want better system 

responsiveness while it‟s 

taking place. (One minor 

catch—when a defrag is 

finished, the summary win-

dow includes a mini-

advertisement for one of 

Auslogics‟ commercial 

products.)  

 

Comodo Firewall Pro. 

WinXP‟s integrated fire-

wall is better than no fire-

wall at all, but it‟s light on 

(Continued on page 10) 

Windows XP:  
Free Utilities For Your OS 

Sometimes, the 

tools included 

with WinXP 

leave something 

to be desired.  
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features and customization 

options. Comodo Firewall 

Pro (www.comodo.com) 

monitors not just the data 

coming into your system, 

but the data going out, as 

well. It also includes a da-

tabase of trusted applica-

tions to help guard against 

unauthorized software be-

ing installed on your sys-

tem without your knowl-

edge.  

 

AVG. Even though WinXP 

gives you a firewall, you‟re 

on your own when it comes 

to antivirus software. You 

could shell out $30 or $40 

for an AV utility, but you 

don‟t have to if you use 

AVG Anti-Virus Free Edi-

tion (free.grisoft.com). 

AVG Anti-Virus Free Edi-

tion doesn‟t include all the 

features of commercial 

antivirus utilities 

(including AVG‟s own), 

but it does provide basic 

virus protection at no cost.  

 

CDBurnerXP. WinXP‟s 

built-in CD burning feature 

is convenient when you 

don‟t have third-party 

burning software installed, 

but its capabilities are lim-

ited. CDBurnerXP 

(www.cdburnerxp.se) lets 

you do things that you 

can‟t do with WinXP 

alone, such as burn DVDs, 

(Continued from page 9) create bootable discs, and 

make backup copies of 

your discs by saving them 

as ISO image files (or burn 

discs from ISO files you 

already have). 

CDBurnerXP will even let 

you create and print cus-

tom covers for several va-

rieties of disc cases.  

  

 Launchy works a lot like 

the Vista Start menu's 

search feature, giving you 

a convenient way to find 

and run your programs 

and files without wading 

through levels of menus. 

Revo Uninstaller. It‟s 

probably happened to all of 

us at least once when try-

ing to uninstall an un-

wanted program via Add 

Or Remove Programs. 

Something goes wrong, 

both the program and its 

entry in Add Or Remove 

Programs get left behind, 

and the uninstall process 

fails thereafter. Revo Unin-

staller 

(www.revouninstaller.com) 

can succeed where Add Or 

Remove Programs fails. 

Aside from running a pro-

gram‟s standard uninstall 

routine, Revo Uninstaller 

can also scan your hard 

drive to ferret out any left-

over files and Registry set-

tings. And if there are pro-

grams installed that you 

don‟t recognize, Revo Un-

installer will let you look 

them up via a Google 

search.  

 

System Utilities  

Personalize your operating 

system and accomplish 

some basic tasks more effi-

ciently with the utilities in 

this section.  

 

BootSkin. Wouldn‟t it be 

nice to look at something 

more attractive or interest-

ing than the standard 

WinXP loading screen in 

the minutes your system 

spends booting up? WinXP 

won‟t let you change the 

default startup image, but 

BootSkin 

(www.stardock.com) will. 

The program includes a 

link to Stardock‟s Web 

site, where you can browse 

and download from among 

about 800 ready-made im-

ages created by BootSkin 

users. (Download them to a 

convenient place such as 

your Desktop and double-

click to automatically ex-

tract and install them in the 

BootSkin menu. Once in-

stalled, you can delete the 

downloaded files.)  

 

DriverView. Information 

about WinXP‟s installed 

drivers is available, but it‟s 

not very easy to find be-

cause you have to hunt it 

down on the operating sys-

tem. If you want a bird‟s-

Free Utilities For Your OS 
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eye view of all your installed 

drivers, or just need informa-

tion about a particular one, 

DriverView 

(www.nirsoft.net) is a handy 

tool. This tiny utility (which 

you don‟t even have to in-

stall) provides a comprehen-

sive and sortable list of every 

driver on your system, and 

for each it reports the file 

name, location, version num-

ber, the company that wrote 

it, the device or software 

component it goes with, and 

more. It can be especially 

useful when you are rein-

stalling a piece of hardware 

and know the driver‟s al-

ready on your system but 

WinXP can‟t seem to find it. 

(NOTE: Because DriverView 

is an EXE [executable] file, 

you may get a security warn-

ing when you try to launch 

it.)  

  

 If Add Or Remove Pro-

grams leaves you high and 

dry when you try to get rid 

of a program, Revo Unin-

staller can usually hunt it 

down and remove it. 

Purrint. Have you ever 

pushed PRINT SCREEN to 

take a snapshot of your 

screen, only to find that it 

doesn‟t seem to do anything? 

Purrint (www.bcheck.net) 

makes that key work as you 

might think it should. It cap-

tures your screen; shows you 

(Continued on page 11) 



a preview of the capture; 

and can save it as an image 

file, save it to the Clip-

board, or, yes, even send it 

to the printer.  

 

Interface Enhancements  

Navigating WinXP might 

be second nature for you, 

but there is always room 

for improvement. The utili-

ties here enhance the 

WinXP features you likely 

use every day.  

 

ClipDiary. We‟ve all used 

the Windows Clipboard to 

copy and paste data, but its 

major limitation is that 

each time you put some-

thing new into the Clip-

board, whatever was previ-

ously in there gets erased. 

It‟s kind of like having a 

closet that holds only one 

outfit. ClipDiary 

(clipdiary.com) improves 

upon the standard WinXP 

Clipboard by using a data-

base that can store count-

less Clipboard entries. A 

quick CTRL-D keystroke 

lets you easily browse the 

contents of your newly vo-

luminous clipboard, and 

perhaps best of all, the con-

tents don‟t get erased when 

you restart your computer.  

 

ActualDoc. Lots of people 

use the Start menu‟s My 

Recent Documents feature 

(Continued from page 10) to get quick access to, well, 

recently used documents. 

But it only displays the last 

15 documents you used, 

which may not take you 

very far back in time.  Ac-

tualDoc 

(www.flexigensoft.com) 

improves on My Recent 

Documents in a couple of 

ways. First, it can remem-

ber an unlimited number of 

files, so you can more eas-

ily find files even if you 

used them many days or 

weeks ago. Then, to help 

you home in on specific 

files types, ActualDoc lets 

you sort the list by cate-

gory so you can display 

just documents, pictures, or 

media files.  

Launchy. Vista users have 

it pretty easy as the Start 

menu‟s search feature lets 

them find and launch any 

application by typing its 

name or just part of it. 

WinXP‟s Start menu, by 

comparison, makes you 

navigate through layers of 

menus—that is, unless you 

have Launchy 

(www.launchy.net). This 

utility indexes every item 

on your Start menu and 

hides until you summon it 

by pressing ALT-Spacebar. 

From there it acts much 

like Vista‟s Start menu 

search feature, displaying 

one or more possible pro-

grams based on what you 

type. Because it can also be 

configured to monitor any 

folders you choose, 

Launchy can be used to 

find and launch document 

files, too.  

These free utilities can 

make using your WinXP 

system more efficient, con-

venient, and secure. So 

who said you can‟t get 

something for nothing?  

by Joseph Moran 

Free Utilities For Your OS 
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TIME TO RENEW 

A 
ll memberships will now be 

renewable annually on April 

1st.  This change in the pay-

ing of annual dues will allow 

the Treasurer to budget our money more 

closely.  If you haven’t already renewed 

your membership, see Linda or Winnie to 

find out your pro-rated amount. 

Alleman, Elizabeth S. . . . . . . . . . . . . . . . . . . . . . esa2204@aol.com 

Anderson, Jean M. . . . . . . . . . . . . . . . . . . . . .jande77893@aol.com 

Berg-Wells, Lois J . . . . . . . . . . . . . . . . . . . . . .luludefl@yahoo.com 

Bernal, Janet . . . . . . . . . . . . . . . . . . . . . . .jgiftofgrace@yahoo.com 

Busch, Linda . . . . . . . . . . . . . . . . . . . . . . . . .lindashrub@juno.com  

Cirvello, Walter . . . . . . . . . . . . . . . . . . . . . . . . . . .waltc1@msn.com 

Florian, Megan J . . . . . . . . . . . . . . . . .eddiegothann@hotmail.com 

Frost, Jack . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . @sbcglobal.net  

Frost, Winnie . . . . . . . . . . . . . . . . . . . . . . .wfrost13@sbcglobal.net 

Gilbertson,  Zack  . . . . . . . . . . . . zgilbertsen@vzw.blackberry.net 

Groth, Charlie . . . . . . . . . . . . . . . . . . . . . . . . . . cgroth2@juno.com 

Galla, Sue Ann . . . . . . . . . . . . . . . . . . . . . . villesuzie@warpnet.net 

Guthman, Carolyn A . . . . . . . . . . . . . . . . . . . . carolyng5@aol.com 

Halley, Jack W . . . . . . . . . . . . . . . . . . . . . . . . . . . . jack96@aol.com  

Hanlon, Terri . . . . . . . . . . . . . . . . . . . . . . terhanlon@comcast.com 

Hobson, Marshia Y . . . . . . . . . . . . . . . . . .omsgadget@yahoo.com 

Kalinoski, Donna L . . . . . . . . . . . . . . . . . . . .donnaleek@juno.com 

Kelroy , Terri and Joe. . . . . . . . . . . . . . . . . . .jktkroy@comcast.net 

Kostelnik, Steve. . . . . . . . . . . . . . . . . . . . steve_kostelnik@usa.net 

Krause, Scott  . . . . . . . . . . . . . . . . .scott.krause@neostudios.com 

Lagoni, Doreen J . . . . . . . . . . . . . . . . . . .bearmagis1899@aol.com 

Larkin, Lester . . . . . . . . . . . . . . . . . . . . . .LesLarkin@Netscape.net 

Martin, Donald  . . . . . . . . . . . . . . . . . . . . dmartin339@comcast.net 

Martin, James K . . . . . . . . . . . . . . . . . . immy@jimmywireless.com 

McDonald, Kathleen . . . . . . . . . . . . . . . . . . . . . . . .clbavp@aol.com  

McDonald, Mark  . . . . . . . . . . . . . . . . . . . . . . . markym36@aol.com  

McEnery, Mike . . . . . . . . . . . . . . . . . . . . mmcenery@sbcglobal.net 

Reinholds, Roy E . . . . . . . . . . . . . . . . . . . . . . . . uncleroy@iwie.net 

Rivera, Julio & Lourdes . . . . . . . . . . jlrivera@db3broadband.com 

Rutledge, James W . . . . . . . . . . . . . . . . . . . . . . . . jrutnet@aol.com 

Sadler, David A . . . . . . . . . . . . . . . . . . . . . . dasadler@comcast.net 

Salsburg, Leslie D . . . . . . . . . . . . . . . . . . . . . . leslie164@juno.com 

Schintgen, Paul . . . . . . . . . . . . . . . . . . . . . . . . .patys@theramp.net 

Seidenberg, Lew  . . . . . . . . . . . . . . . . . . . . . . . . . .drlew1@aol.com 

Seidenberg, Robin  . . . . . . . . . . . . . . . . . . . .anguslechat@aol.com 

Shaughnessy, Diane . . . . . . . . . . . . . . . . . . . . . . . . . . .sditto@eww 

Straw, Gerald . . . . . . . . . . . . . . . . . . . . . . . . .gkstraw@comcast.net 

Urh, John  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .urhgeorge@aol.com 

Vogt, Grace . . . . . . . . . . . . . . . . . . . . . . . . . . g.vogt@sbcglobal.net 

Wells, Alden H . . . . . . . . . . . . . . . . . . . . . . . . .luludefl@yahoo.com  

Wilson, Dennis  . . . . . . . . . . . . . . . . . . . . . dcwilson@exexpc.com 

Members e-mail 

Share your Web Site 

with us. 

Advertise it here, 

E-mail me at 

editor@lcace.org 

 

Take a good 

look, you just 

might see 

yourself. 

LCACE CLUB PICTURES  

 @ http://lcace.org/PhotoAlbums.htm 
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Serving Lake County, Illinois 

Since 1983 

Visit us @ http://www.lcace.org 

NEXT MEETING 

September 13, 2008 

Grayslake Public Library 

@ 12:30 pm. 

Presented by 

Mike McEnery 

 

OneCare 2.0  
Protect, maintain, and manage your computer with  

this always-on PC-care service from Microsoft. 

Lake County Area Computer Enthusiasts 

409 S. Elmwood Ave. 

Waukegan, IL 60085 
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